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Warranty Statement

THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED “AS IS,” AND IS SUBJECT
TO BEING CHANGED, WITHOUT NOTICE, IN FUTURE EDITIONS. FURTHER, TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, AGILENT DISCLAIMS ALL
WARRANTIES, EITHER EXPRESS OR IMPLIED WITH REGARD TO THIS MANUAL AND
ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED TO THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. AGILENT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL

OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, USE, OR
PERFORMANCE OF THIS DOCUMENT OR ANY INFORMATION CONTAINED HEREIN.
SHOULD AGILENT AND THE USER HAVE A SEPARATE WRITTEN AGREEMENT WITH
WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFLICT
WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT WILL
CONTROL.

DFARS/Restricted Rights Notice

If software is for use in the performance of a U.S. Government prime contract or
subcontract, Software is delivered and licensed as “Commercial computer software” as
defined in DFAR 252.227-7014 (June 1995), or as a “commercial item” as defined in FAR
2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or
any equivalent agency regulation or contract clause. Use, duplication or disclosure of
Software is subject to Agilent Technologies’ standard commercial license terms, and
non-DOD Departments and Agencies of the U.S. Government will receive no greater than
Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users
will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or
DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.




Safety Notes

The following safety notes are used throughout this document. Familiarize yourself with
each of these notes and its meaning before performing any of the procedures in this
document.

WARNING Warning denotes a hazard. It calls attention to a procedure which, if
not correctly performed or adhered to, could result in injury or loss
of life. Do not proceed beyond a warning note until the indicated
conditions are fully understood and met.

CAUTION Caution denotes a hazard. It calls attention to a procedure that, if not
correctly performed or adhered to, could result in damage to or destruction of
the instrument. Do not proceed beyond a caution sign until the indicated
conditions are fully understood and met.

Definitions

e Specifications describe the performance of parameters covered by the product warranty
(temperature —0 to 55 °C, unless otherwise noted.)

¢ Typical describes additional product performance information that is not covered by the
product warranty. It is performance beyond specification that 80% of the units exhibit
with a 95% confidence level over the temperature range 20 to 30 °C. Typical
performance does not include measurement uncertainty.

¢ Nominal values indicate expected performance or describe product performance that is
useful in the application of the product, but is not covered by the product warranty.

e Characteristic Performance describes performance parameter that the product is
expected to meet before it leaves the factory, but is not verified in the field and is not
covered by the product warranty. A characteristic includes the same guard bands as a
specification.
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U3045AMO08 Introduction

Introduction

This document describes how to use and service the U3045AMO08 Multiport Extension Test
Set with the Agilent N5244A or N5245A 4-Port PNA-X for a 12-Port network analyzer
solution.

Figure1 Front Panel N5245A with U3045AMO08
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U3045AMO08 Description

Description

The Agilent U3045AMOS is a 8-Port mechanical switch multiport extension Test Set. The
Test Set adds eight test ports to a 4-Port N5244A (10 MHz to 43.5 GHz, or the N5245A
(10 MHz to 50 GHz) PNA-X Network Analyzer. The PNA-X with Option 551 provides
12-Port calibration and full cross bar measurement capability.

The U3045AMO08 mechanical switches provide low insertion loss for the best dynamic
range performance, but have slower switching speed and limited life when compared to
solid-state switches. The operational frequency range of the extension test set is 10 MHz to
50 GHz.

The U3045AMO8 requires a network analyzer with Test Set I/O interface for operational
control. An external personal computer is not required.

The N5244/45A PNA-X Network Analyzer will be referred to throughout this document as
the PNA-X. The U3045AMO08 will be referred to as the Test Set.

Network Analyzer Requirements

e The N5244/45A requires Option 551 and test set file U304xAM08_PNAX_p4.tsx
(for N-Port error correction and multiport measurement capability).

e The N5244/45A requires Option 400 to provide the test set interface connections
e PNA-X firmware revision: N5244/45A > A.09.22.07

The following test set file must be installed into the PNA-X file directory:
c:\Program Files\Agilent\Network Analyzer\testsets

4-Port PNA-X requires test set: U304xAMO08_PNAX_p4.tsx

More PNA information is available on the following websites:

¢ Documentation - http://www.agilent.com/find/pna
¢ Network Analyzer Firmware - http:/na.tm.agilent.com/pna/firmware/firmware.htm

e U3045AMOS8 Test Set Files - http:/na.tm.agilent.com/multiport (see test set files)

Verifying the Shipment

To verify the contents shipped with your product, refer to the “Box Content List” included
with the shipment.

Inspect the shipping container. If the container or packing material is damaged, it should
be kept until the contents of the shipment have been checked mechanically and electrically.
If there is physical damage refer to “Contacting Agilent” on page 71. Keep the damaged
shipping materials (if any) for inspection by the carrier and an Agilent Technologies
representative.
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U3045AMO08 Available Options

Available Options

Test Set Options

The Test Set has one available Test Set option:
Refer to Figure 38 on page 48.

e Standard - mechanical switches for low loss.

Interface Option
The available Test Set cable options:

e U3021PX2 Option 445 includes two kits to connect the 4-Port N5245A to the Test Set; a
Lock Link kit U3021M-045 (U3021-60006), and Cable kit 445 PNX2 (U3021-60089).

Mounting Kits
The Test Set available cable options:

e U3021M Option 045 (Locking links for the Test Set to the PNA-X, can be order
separately).

e U3045AMO08-1CP Front Handle Kit (5063-9229)
e U3045AMO08-1CM Rack Mount Kit without Handles (5063-9216)
e U3045AMO08-1CN Rack Mount Kit with Handles (5063-9236)
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U3045AM08 Specifications

Specifications

Specifications for the Test Set are characteristic for the system performance of the PNA-X
and the Test Set. Before using the PNA-X and Test Set a calibration is recommended for
best measurement performance. Actual performance of the system is based on the
customer’s PNA-X and options that are used with the Test Set. A functional certificate is
only offered for the Test Set.

When connected to a PNA-X, this Test Set will degrade the performance at the test ports.
The internal switch paths reduce test port power and power to the receivers. This affects
the test port power of the PNA-X and also reduces dynamic range. The reflection tracking
values measured in the “Operational Check” on page 39 can be subtracted from the
analyzers dynamic range to determine the approximate performance of the system.

CAUTION The life expectancy of the following switches are 5 million cycles. When
making measurements using more than one port, single sweeps are
recommended to minimize switch cycles.

e N1811TL (x16, N1811-60023)

Power Requirements
Verify that the required ac power is available before installing the Test Set to the PNA-X.
e 100/120/220/240 VAC (50/60Hz)

¢ The instruments can operate with mains supply voltage fluctuations up to + 10% of
the nominal voltage.

¢ Air conditioning equipment (or other motor—operated equipment) should not be placed
on the same ac line that powers the Test Set and PNA-X.

¢ Table 1 contains the maximum wattage for all instruments. This table can be use to
determine the electrical and cooling requirements.

Table 1 Power Requirements
Instrument Maximum
Wattage
N5244/45A 450
U3045AMO08 350

WARNING This is a Safety Class I Product (provided with a protective earthing
ground incorporated in the power cord). The mains plug shall be
only be inserted in a socket outlet provided with a protective earth
contact. Any interruption of the protective conductor inside or
outside of the product is likely to make the product dangerous.
Intentional interruption is prohibited.
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U3045AM08 Specifications

Environmental Requirements

Refer to the PNA series standard documentation for environmental requirements.

Environmental Tests

The Test Set complies with all applicable safety and regulatory requirements for the
intended location of use.

¢ Temperature 0 - 50 °C

¢ Altitude (Operation)
3,000 meters (~10,000 feet)

¢ The instrument can safely operate in a relative humidity of 80% for temperatures to
31 degrees C, decreasing linearly to 50% relative humidity at 40 degrees C.
Equipment Heating and Cooling

If necessary, install air conditioning and heating to maintain the ambient temperature
within the appropriate range. Air conditioning capacity must be consistent with the BTU
ratings given in Table 1.

CAUTION Ventilation Requirements: When installing the instrument in a cabinet, the
convection into and out of the instrument must not be restricted. The ambient
temperature (outside the cabinet) must be less than the maximum operating
temperature of the instrument by 4 °C for every 100 watts dissipated in the
cabinet. If the total power dissipated in the cabinet is greater than 800 watts,
forced convection must be used.

Required Conditions for Accuracy Enhanced Measurement

Accuracy—enhanced (error—corrected) measurements require the ambient temperature of
the PNA-X and Test Set to be maintained within + 1 °C of the ambient temperature at
calibration.

Dimensions and Space Requirements

Standard installation of the Test Set and PNA-X includes configuration and installation on
a customer provided lab bench or table top of adequate size and strength. For weight,
dimensions and space requirements, refer to the network analyzer documentation that is
used to configure the Test Set.

Table 2 Instrument Dimensions
Model Weight Height Width Depth
U3045AMO08 13.6 kg (30 1b) 19 cm 42.5 cm 50 cm
(7.51n) (16.7 in) (20 in)
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U3045AMO08

Specifications

Maximum Power Levels

CAUTION It is recommended that you do not operate components near damage levels
(+25 dBm). The power levels must be 3 dB below maximum level to ensure no
damage, see Table 3.

Table 3 Power Levels

Maximum U3045AMOS8 Test Port RF Power Levels:

PORT 5-12

+25 dBm 0 Vde

Maximum U3045AMOS8 Access Ports:

SOURCE OUT +15 dBm 0 Vdc

CPLR ARM +15 dBm 0 Vdc

CPLR THRU +15 dBm 0 Vdc

RCVR OUT +15 dBm 0 Vdc
NOTE Refer to your PNA-X specifications to determine the maximum input power

levels for the access and test ports, or to optimize the power levels in the
receivers.

NOTE

Damage and maximum levels are not necessarily the optimum level.
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U3045AMO08

Reflection Tracking Performance

Specifications

Specifications for the reflection tracking are typical and are intended as non-warranted

information.

NOTE Typical specifications are based on 1 to 2 units performance. Refer to Table 4
below, and “Operational Verification Limits for Reflection Tracking”, Table 10

on page 39.

Table 4 Typical Reflection Tracking PNA-X

Frequency Ports 1 to 4 Ports 5 to 12
10 MHz to 2 GHz -1 -1
2 GHz to 5 GHz -2 -2
5 GHz to 10 GHz -3 -2.5
10 GHz to 15 GHz -4 -3
15 GHz to 20 GHz -5 -3.5
20 GHz to 25 GHz -5.5 —4
25 GHz to 30 GHz -6 -4.5
30 GHz to 35 GHz -6.5 5
35 GHz to 40 GHz -7 -5.5
40 GHz to 45 GHz -7.5 -6
45 GHz to 50 GHz -8 -6.5
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U3045AMO08 Front and Rear Panel Features

Front and Rear Panel Features

Figure 2 U3045AMO08 Front Panel

Access Ports 5 to 12 Test Ports

Active
LED

Standby Switch Test Port LED’s

Test Ports — 2.4 mm Bulkhead (male)
® Portb5-12

Access Ports - 2.4 mm (female)

RCVR OUT
CPLR ARM
CPLR THRU

SOURCE IN

Test Port’s LEDs

An illuminated LED indicates an active port in Source or Receiver mode. On the front
panel “S” indicates Source test ports and “R” indicates Receiver test ports.

Standby Switch

Note that this switch is Standby only, not a line switch. The main power cord can be used
as the system disconnecting device. It disconnects the mains circuits from the mains

supply.

Active LED

When the Test Set is connected and addressed by a PNA-X, the LED is On (illuminated).
The LED is Off (not illuminated) when the Test Set is in Standby, or not addressed by the
PNA-X.
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U3045AMO08 Front and Rear Panel Features

Figure3 U3045AMO08 Rear Panel

Control Lines/Voltage Adjust

Line Module Test Set Interface  Pass Through Interface Chassis Ground

Control Lines and Voltage Adjust

For further information pertaining to control lines and voltage adjustments see. Refer to
“Control Lines” on page 35.

Chassis Ground

A threaded terminal post for connecting the Test Set to a conductive object, cabinet or
structure to ensure a common potential and reduce leakage current in a system. Requires
an English 1/4-20 thread nut (2950-0004) and lock washer (2190-0067).

Pass Through Interface

The Pass Through Interface is used to connection to another test set.

Test Set Interface

The Test Set Interface connector is used to send address and data to the Test Set from the
PNA-X.

Line Module

The line module contains the power cord receptacle.The line fuse, as well as a spare, reside
within the line module. Figure 4 illustrates where the fuses are located and how to access
them.

Install the instrument so that the detachable power cord is readily identifiable and is
easily reached by the operator. The detachable power cord is the instrument disconnecting
device. It disconnects the mains circuits from the mains supply before other parts of the
instrument. The front panel switch is only a standby switch and is not a LINE switch.
Alternatively, an externally installed switch or circuit breaker (which is readily
identifiable and is easily reached by the operator) may be used as a disconnecting device.

CAUTION Always use the three-prong ac power cord supplied with this product. Failure
to ensure adequate grounding by not using this cord may cause damage to the
product.
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U3045AMO08 Front and Rear Panel Features

Power Cords

A line power cord is supplied in one of several configurations, depending on the destination
of the original shipment. Agilent can supply additional certified power cords to meet region
electrical supply and receptacle configurations. Please contact Agilent at: www.agilent.com
for assistance in power cord selection.

WARNING The detachable power cord is the instrument disconnecting device. It
disconnects the mains circuits from the mains supply before other parts of
the instrument. The front panel switch is only a standby switch and is not a
LINE switch (disconnecting device).

Available Fusses

e Fuse (F 5 A/250V, 2110-0709) UL listed and CSA certified.
¢ Fuse (F 8 A/250V, 2110-0342) UL listed and CSA certified.

WARNING For continued protection against fire hazard, replace fuses, and or
circuit breakers only with same type and ratings. The use of other
fuses, circuit breakers or materials is prohibited.

Figure4 Line Fuse

CAUTION Verify that the premise electrical voltage supply is within the range specified
on the instrument.
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U3045AMO08 System Setup with N5244/45A

System Setup with N5244/45A

WARNING The opening of covers or removal of parts is likely to expose
dangerous voltages. Disconnect the instrument from all voltage
sources while it is being opened.

Preparing the PNA-X
1. Remove the feet from the bottom of the PNA-X.

2. Remove the 2 lower standoffs and screws (0515-1619) from the rear panel on the
PNA-X.

Figure 5 Rear Bottom Feet

Standoffs (x2)

Feet (x4)

3. Install the two rear locking feet (5023-0132) onto the PNA-X, using the included screws
(0515-1619), where the standoffs were removed.

Figure 6 Install Locking Feet on PNA-X

Locking Feet
(5023-0132)

Screws (0515-1619)
Included in package
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U3045AMO08 System Setup with N5244/45A

4. Remove the top two standoffs and screws (0515-2317) from the rear panel on the
Test Set.

5. Install the two rear locking feet onto the Test Set. The N5242-20138 is the right foot
and the N5242-20138 is the left foot. Two screws (0515-2317) are included with this
option.

Figure 7 Install Locking Feet on Test Set

N5242-20138 N5242-20139

6. Place the PNA-X on top of the Test Set and ensure that the front frame of the PNA-X is
positioned slightly forward of the locks that are attached to the Test Set. Slide the
PNA-X back so the locks engage the front frame of the analyzer.

Figure 8 Locking the Analyzer

Network Analyzer

Front Frame
Slide the network analyzer
back to engage the lock link in

<«——— the back of the network
analyzer’s front frame,

crew

Test Set
Front Frame
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U3045AMO08 System Setup with N5244/45A

7. Secure the PNA-X’s lower locking feet to the Test Set upper locking feet, using the
spring—loaded screws on the locking feet. If the PNA-X's lower locking feet are not
aligned with the screw holes in the Test Set's upper locking feet, loosen the screws
securing the feet to the instrument slightly to align and tighten.

Figure 9 Locking Feet Screws

NOTE There are two Lock-Feet kits available. Refer to “Contacting Agilent” on

page 71 for ordering information.

e PNA-X -5023-0132 (Kit includes locking feet and screws)
e Test Set — N5242-20138 (right foot) and N5242-20139 (left foot).

e Screw — 0515-2317

14
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U3045AMO08 System Setup with N5244/45A

RF Interface Cable Connections

Figure 10 on page 15 illustrates the cable configuration of the Test Set to the PNA-X. The
cables have been supplied with Kit U3021-60089.

1. Remove the SOURCE OUT to CPLR THRU and RCVR IN to CPLR ARM jumpers (x8)
on the PNA-X. The RCVR R1 to SOURCE OUT reference loop jumpers (x4) remain on
the front panel.

2. Connect the RF interconnect cables (N5247-20016 and N5247-20017) from the PNA-X
to the Test Set in the order listed. As you are connecting each cable, torque to 8 in-lb.
Refer to Table 5 and Figure 10 on page 15.

CAUTION Over torque will cause damage to the Test Set and may cause connectors to
spin or become loose.

Table 5 N5244/45A RF Interface Cable Connection (Option 445)

Numeric | RF Cables From PNA-X To Test Set
Order
1 U3047-20016 CPLR ARM CPLR ARM
2 U3047-20016 RCVR IN RCVR OUT
3 U3047-20017 CPLR THRU CPLR THRU
4 U3047-20017 SOURCE OUT SOURCE IN

Figure 10 illustrates the final two digits of the part number for each cable. The cables must
be connected in the numeric order listed in Table 5.

Figure 10 PNA-X RF Interface Cable Connections

16 (x8)
17 (x8)

3. Connect the PNA-X Test Set I/O cable (8120-6818) to the Test Set Interface connector on
the rear panel.
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U3045AMO08 System Setup with N5244/45A

Figure 11 Rear Panel N5245A with U3045AMO08

16 User’s and Service Guide U3045-90001



U3045AMO08 Controlling the U3045AMO08 with N5244/45A

Controlling the U3045AMO08 with N5244/45A

This section will describe how to operate the Test Set with the PNA-X.

A PNA-X must be used to control the Test Set using the Test Set I/O interface on the rear
panel. There are three methods to control the Test Set. Multiport mode is recommended
due to ease of use, and multiport calibration capability (N-Port).

e “PNA-X Multiport Mode” on page 18.
e “Interface Control Mode” on page 25.
e “GPIB Control Mode” on page 29.

Sweep Setup for Multiport and Standalone PNA Modes

Due to the extra electrical length of the test set and test port cables, it is recommended
that the analyzer’s Sweep Setup be configured to Stepped Sweep before calibrating. This is
slower than the Analog Sweep, but is more accurate. Stepped Sweep is available on all
PNA models.

1. On the PNA select STIMULAS > Sweep > Sweep Setup.
2. Select Stepped Sweep.
3. Set the Dwell Time to 5 us > OK.

Figure 12 PNA Sweep Setup

Sweep Setup il
| 1 - I
Channel

—P»[v Stepped Sweep - sweep moves in discrete steps
— I 5 usec E Dwell Time - delay before measuring each point

I 0 usec E Sweep Delay - delay before first point of sweep

[~ Fast Sweep - reduce measurement settling time

Sweep Sequence
® Standard

Point Sweep: measure all parameters before stepping to the
next point

OK Cancel Help
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U3045AMO08 Controlling the U3045AMO08 with N5244/45A

PNA-X Multiport Mode

The PNA-X requires Option 551 for multiport mode. The PNA-X must have the Test Set
file installed to enable the PNA-X to control the Test Set. The PNA-X multiport mode
allows you to select measurement ports, complete an N-Port calibration, operate control
lines, and rename test ports. Refer to the Help menu for more information.

Multiport Mode Operation

1. The Option 551 must be installed for multiport capability. To access the multiport
application select Utility > System > Configure > Multiport Capability.

2. Select U304xAMO08_PNAX_p4 (12-Port System) from the drop-down menu and select
Restart as a multiport PNA with this testset > OK. The PNA-X will restart the network
application with the Test Set interface features.

If the Test Set is not available in the drop-down list, it will be necessary for you to copy the
required Test Set file to the PNA-X hard drive. The current version of the Test Set files are
available on the web at http:/na.tm.agilent.com/multiport. Copy the appropriate file to
c:\program files\ Agilent\Network Analyzer\testsets directory.

Figure 13 Test Set Selection

File Trace/Chan Response Marker/Analysis Stimulus | Utility Help
S$11 LogM 10.00dB/ 0.00dB

Security...
SICL/GPIB/SCPL... Configure >
Code Emulation Service 4
Control Panel... Touchscreen
System Z0... |

Power Meters... o [

External Device Config... KEyzts

Millimeter Module Config...
Preferences...
LAN Status...

-30.00 i

-40.00

-50.00

>Ch1: Start 10.0000 MHz — Stop 50.0000 GHz
CH1 11 2f2 3[3 4[4 5[5 66 77 88 93 1010 11711 12]12

Cont.  CH1: S11 No Cor LCL
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U3045AMO08 Controlling the U3045AMO08 with N5244/45A

External Test Set Control Operation

To verify that the network application has the Test Set interface features, select
Trace/Chan > Channel > Hardware Setup > External Test Set > Other. The Test Set will be
displayed as External Test Set Control-U3045AMO08. Refer to Figure 14.

Figure 14 External Test Set Control

File | Trace/Chan Response MarkerfAnalysis Stimulus Utility Help

Trace >

50.0 Turn On Channel...

Turn Off Channel...
Select Channel...

New Trace...

Trace Max
Measurement Class... Measurement Class...

Copy Channel...

Hardware Setup [d Path Config...

Pulse Generators Setup...
IF Config...

External Testset Control - U304xAMOS_PNAX x|

Select Test Set by ID Control Lines
Interface Control... Select D |0 Linel  LOW
External Test Sets Line2  LOW

= - ~Test Set
Mechanical Device Line3  LOW
_ _ Testset ~

o Lined  LOW
7 Show Test Set Properties [7 Encble Test Set Control Line5  LOW
Fast et — MULTIPORT MODE — Line6  LOW
Line7  LOW
Port Control Line8  LOW

Port1 Port 2 Port 3 Port 4
-40.00 User Preset PN N ENA N TIEE (S
-50.00 onh | OFF Port 5 Port 6 Port 7 Port 8 .
>Ch1: Start 10,0000 MHz — Stop 50.0000 GHz | R N O A |
oK Cancel Help.

CH1 1T 22 3(3 4[4 5[5 &6 7{7 88 3[9 100 11T 12012

Cont.  CH1: 811 No Cor LCL

This menu will allow the physical Ports 1 thru 12 to be identified as any port for your
convenience. For example; Port 5 can be re-named Port 2.

The External Test Set Control-U3045AMO08 also allows control of the DUT control lines,
refer to “Control Lines” on page 35. To change the state from LOW to HIGH, select the
graphical user interface (GUI) for the specific control (LINE 1 thru 8), click OK. Each line
can be controlled separately. Select the Port Control down arrow for Ports 9 thru 12.

User’s and Service Guide U3045-90001 19



U3045AMO08 Controlling the U3045AMO08 with N5244/45A

Selecting S-Parameter Measurement

S-Parameter selection can be accomplished using Response > Measure. Use the
drop-down menu to select 1 of 144 S-Parameters for the 12-Port system. The first number
in the Sxx selection is the Receiver Port and the second number will be the Source Port.
Any port can be selected to be the Receiver, Source or both, as in S11. The front panel R
LED indicates the port is the Receiver and the S LED indicates the port is the Source.

Figure 15 S-Parameter Measurement

File Trace/Chan | Response Marker/Analysis Stimulus Utility Help
Measure Balanced »  S27?
Format > S3?
Scale > 542
Display » 852
»
>

Avg S6 ?

Cal s7?
S8 ?
$97?
S10?
S117?
S127?
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Selecting New S-Parameter Measurement

S-Parameter Tab: Multiple S-Parameters can be made by selecting Trace/Chan > Trace >
New Trace. Use the drop-down menu and select of any of the 144 S-Parameter's.

Figure 16 New S-Parameter Measurement
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Balanced Tab: Balanced Measurements can be configured by selecting the Balance tab

in the New Trace menu.

For more information on balanced (differential) component measurement, refer to the
Application Note 1373-1 and 1373-2 (5988-5634EN and 5988-5635EN) at
http://www.home.agilent.com. In the search menu type “Multiport and Balanced.”

Figure 17 Selecting Balanced Measurements
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Receivers Tab: The S-Parameter measurements can be ratioed with selectable
Denominators for each port and receiver. Refer to the standard PNA-X documentation for

more information.

Figure 18 Receiver Measurements
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N-Port Calibration with N5244/45A

It is recommended that you perform an ECal characterization to minimize the connections
required for multiple port calibration. The N4693AB Option MOF is recommended with
cable (85133F) if you are calibrating at the PNA-X and Test Set ports.

Characterize the ECal module with adapters that will not be used in the measurement of
the DUT. To characterize the ECal module select Response > Cal > More > ECal >
Characterize ECal Module.

Calibrate at the end of the test port RF cables and any adapters that are used to connect
the DUT. This removes the effect on the measurement of the DUT. Failure to do this will
create ripple and other measurement errors.

NOTE If measurement errors occur, ensure the newest version of firmware is
installed on the PNA-X. Measurement errors can be a result of firmware
algorithms. Consult with Agilent Service or firmware web page for the latest
PNA-X Option 551 firmware revisions and history.
http:\ \na.tm.agilent.compna\firmware \ firmware.htm.

Figure 19 ECal Characterization
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NOTE

If the PNA-X has Option 029 or H29 (noise figure capability) verify that the
path configuration is set to Default. If the PNA-X is not in Default
configuration, ports 5 and 9 will not operate correctly. Select Trace/Chan >
Channel > Hardware Setup > Path Cong... and in the drop-down menu select
Default > OK. Save this configuration as a User Preset by selecting Save >
User Preset > Save current state as User Preset. Do not use the factory
Preset (User Preset Off), the PNA-X will return to Option 029 path
configuration.

Figure 20 RF Path Configuration
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1. On the PNA-X select Response > Cal Wizard.

a. If using a mechanical cal kit, select SmartCal (Guided Calibration) > Next.

b. If using an ECal module, connect the ECal to an available PNA-X USB port and
select Use Electronic Calibration (ECal) > Next.

Figure 21 Begin Calibration
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2. Continue following the Cal Wizard prompts. In the Select Calibration Ports and ECal
Module dialog box click the Select All, check box, or select the ports you are calibrating
and click Next. If an ECal characterization has been done, select View/Select ECal
Module and select the previously saved user file from step 1.

Figure 22 12-Port Calibration
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3. Connect the ECal or the mechanical cal kit to the ports you are calibrating following the
Cal Wizard prompts and click Measure after each connection. The electrical delay value
may be shown in the dialog box after the last measurement, click OK.

4. At the Calibration Completed prompt, select Save As User Calset, type the name and
Save. See Figure 31 on page 41.

5. After calibrating Test Set ports, use a quality load and short to verify the calibration on
each port or end of the test cable. Measure reflection and confirm the return loss is as
expected. If the result is not as expected, repeat the calibration without the Test Set and
ensure that the PNA-X is in standard (non-multiport) mode.

NOTE If measurement errors occur, ensure the newest version of firmware is
installed on the PNA. Measurement errors can be a result of firmware
algorithms. Consult with Agilent Service or firmware web page for the latest
PNA Option 551 firmware revisions and history.
http:\ \na.tm.agilent.compna\firmware \ firmware.htm.
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Interface Control Mode

The Interface Control feature allows you to send data and remote commands to control
external equipment using the GPIB, Material Handler I/O, Test Set I/0, and Auxiliary I/O
without the need of an external computer. Refer to PNA-X Help menu, “Rear Panel Tour”
and “Interface Control.”

This section includes:
e How to Access Interface Control Settings

¢ Interface Control dialog box

NOTE The interface control mode will not function properly when using multiport
mode. The multiport mode will reset the switch path commands of the
interface control. It is recommended that the PNA-X be restarted in
stand-alone mode if the interface control is being used.

e A unique set of control data can be sent for each channel. In addition, a unique set of
control data can be sent before the channel sweep starts and after the sweep ends.

¢ Interface Control settings can be saved and recalled from the Interface Control dialog
box or with Instrument State Save and Recall.

¢ Interface Control settings can be copied to other channels using Copy Channels.
e Control data can only be WRITTEN to the interfaces, NOT READ from the interfaces.

¢ Control data is sent in the following order and this order cannot be changed:
Refer to the PNA Help menu.

1. GPIB Interface

2. Material Handler Interface
3. Test Set Interface

4. Dwell Time
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How to Access Interface Control Mode

1. To access the Interface Control mode, select Trace/Chan > Channel > Hardware Setup
> Interface Control in the drop-down menu, and select Enable Interface Control.

NOTE The PNA-X Series Network Analyzer includes the Interface Control
application and rear panel connection. Please review this application before
connecting the Test Set to the PNA-X. Information regarding this application

can be found in the PNA-X Help menu, Interface Control. The application is
shown below.

File | Trace/Chan Response Marker/Analysis Stimulus Utility Help
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Trace Max
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Hardware Setup ld Path Config... Global
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e — e — ¥ Enable Cortrol
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External Test Sets »
Mechanical Devi
1000 g =
Handler /0 Contral Test Set 140 Contol (add. data)
-20.00 ¥ Enable Contiol ¥ Enable Contiol
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Fort © 0151
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Using Interface Control Mode
An Instrument Preset will reset all of the fields to their default settings.

NOTE If an error is encountered when sending Interface Control data, an error
message is displayed on the PNA-X screen and the Channel Trigger State is
set to Hold. You must fix the condition that caused the error, then change the
Channel Trigger State to its original setting

Figure 23 Interface Control
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Enable Interface Control: @

Enables and disables ALL Interface Control communication. When cleared (default
setting) Interface Control is disabled and NO data is sent. To send data, the individual
interfaces must also be enabled.

Test Set I/0 Control (addr.data): @

Provides control of the Test Set I/O Interface on the rear panel of the PNA-X. Used to
control your Test Set.

Only positive integers are allowed to select switch positions or states of DUT control
interface lines. Refer to “Address and Data Values” on page 32.

Address and data integers must be separated by a period. Each set of entries should be
separated by a new line, or carriage return. The front panel Enter key can be used to insert
a new line into the field. The quantity of Test Set I/O entries that can be entered is limited
by the available memory of the PNA-X.

Address and Data example: addr.data @

0.0
16.1
32.2
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Channel: @

Specifies the channel number for dialog settings. Each channel is configured individually.
The drop-down list illustrates the channels that currently have measurements. There
must be at least one displayed trace for the Test Set I/O Interface to function.

Channel Control Label: ®
Specifies the label to be displayed on the PNA-X screen during the channel sweep.

Before Sweep Start — After Sweep End Tabs: (6)

Commands (GPIB, I/O’s and Dwell) can be sent Before Sweep Start and After Sweep End.
However, they are configured and enabled separately on the Interface Control dialog box.
For example; to send a command before and after a PNA-X sweep, the Enable Interface
Control check box must be selected and commands entered in both the Before Sweep Start
and After Sweep End tabs. The Before Sweep Start data is sent before the first trace on
the channel begins sweeping. The After Sweep Start data is sent after the last trace on
the channel sweep is completed.

Dwell After Command: @

Specifies a wait time, in milliseconds, after all commands to all interfaces are sent. Any
positive integer is allowed. This is used to allow all external devices to settle before
beginning a measurement. An erratic trace could indicate that more settling time is
necessary.

Handler I/0 Control and Aux I/0 Output Voltage:

Provides I/O interface control through the rear panel of the PNA-X. Refer to the PNA-X
Help menu for further information.

Reset All:

Sets all fields on all channels to their default values.

Save and Recall:

Saves and recalls the contents of the dialog box. If the Interface Control dialog box is
populated with settings during an Instrument State Save, the settings are automatically
recalled with the instrument state settings. Interface control uses an *.xml file type. An
example file is stored on the PNA-X hard drive. You can recall it into the dialog, or you can
open and edit it with a word processor, such as Word Pad.

OK:
Applies the settings and closes the dialog box.

Cancel:
Does not apply changes that were made and closes the dialog box.
Help:

Provides additional information for using the interface control application.
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GPIB Control Mode

The PNA-X GPIB Command Processor feature allows you to send remote commands and
data to the PNA-X rear-panel GPIB connector and Test Set I/O connector. More
information regarding the GPIB Command Processor can be found in the PNA-X Help
menu.

e Overview
e How to Access GPIB Command Processor

e GPIB Command Processor Console

Overview of the GPIB Control

The GPIB Command Processor allows you to send address and data to control an external
Test Set, without needing to create a remote program. The user is required to manually
input address and data using the GPIB Command Processor Console in the PNA-X Help
menu.

¢ GPIB Command Processor settings can not be saved or recalled.

e Address and data can be written from the GPIB Command Processor.
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How to Access GPIB Command Processor

1. To access the GPIB Command Processor select Utility > System > Configure >
SICL/GPIB/SCPI.

Figure 24 Utility Configure
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2. Select GPIB Command Processor Console > OK.

Figure 25 GPIB Command Processor
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GPIB Command Processor Console

Write Commands Once the GPIB Command Processor Console is open, commands can
remotely control the external Test Set I/O connector by sending the following:

address: a integer number

data: a integer number

Address and data are separated by a comma. Commands should be separated by a new
line, or carriage return.

For example:

CONT:EXT:TEST:DATA <address>,<data>
CONT:EXT:TEST:DATA 0,0

Example: CONT:EXT:-TEST:DATA 0,0

“{ GPIB Command Processor

For current command list, type :5Y¥S5Tem:HELF:HEADers?
To guit, type Control-Z, then Enter.
Tupe ¥ followed by a filename to execute commands from a text file.

GPIB> COMT:EXT:TEST:DATh B.8
time =Ams
GPIB> _

Refer to “Address and Data Values” on page 32.
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Address and Data Values

Setting the Test Port Paths with Address and Data

Refer to Table 6 on page 32 and Figure 26 on page 33 for information to set the internal
switch paths of the Test Set.

The address is the first value in the Test Set I/O control or GPIB data command. The
second value controls the source and receiver paths of the ports. To select a Test Set port
configuration both switches must be set to complete the source and receiver paths. To do
this you must add the data values together to determine the data command value for each
port, which is the second number in the Test Set I/O or GPIB command.

Example 1:

If the ports have the same address, only one command is needed.

Port 5 is the Source and Ports 9 is the Receiver.

Source Port 5 = address 0, data 1 and Receiver Port 5 = address 0, data 16. The data values
are added together, the entry will be 0.17. See Table 6 on page 32. Refer to “Interface
Control Mode” on page 25 and in “GPIB Control Mode” on page 29.

Example 2:

If the ports have different addresses, two separate address data commands must be used.
Port 5 is the Source and Port 6 is the Receiver.

Source Port 5 = address 0, data 1 and Receiver Port 6 = address 16, data 16.
Two separate commands must to be sent, you may use the same dialog box. Send address 0
and data 1 in one command line, and address 16 and data 16 in the second line.

For further information refer to “How to Access Interface Control Mode” on page 26 and
“How to Access GPIB Command Processor” on page 30.

Table 6 Test Port Address and Data Values

Address Source Path | Receiver
Path
Data | 0 1 2 0 16 | 32
0 Ports | 1 5 9 1 5 9
16 Ports | 3 6 10 |3 6 10
32 Ports | 4 7 11 | 4 7 11
64 Ports | 2 8 12 |2 8 12

Refer to Figure 38, “U3045AMO08 RF Block Diagram,” for in-depth RF path information.
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Figure 26 Address and Data Example 1 (Port 5 and 9)
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Setting the Control Lines with Address and Data Values

This section describes how to control the DUT control lines. Refer to “Control Lines” on
page 35.

All DUT control lines remain in a high logic state until set by the address data
0 = logic high. All control lines are set by the sum of the data sent to the Test Set.

Example: To set control line 1 and 8 to a low state send command 112.129 (1 + 128).
All other lines remain in a high state.

Table 7 Test Set DUT Control Address and Data Logic Table

Address | Data Description Pin
112 0 ALL the Control Lines set to logic high 13
112 255 ALL the Control Lines set to logic low 14
112 1 DUT Control Line 1 set to logic low 1
112 2 DUT Control Line 2 set to logic low 2
112 4 DUT Control Line 3 set to logic low 3
112 8 DUT Control Line 4 set to logic low 4
112 16 DUT Control Line 5 set to logic lowe 5
112 32 DUT Control Line 6 set to logic low 6
112 64 DUT Control Line 7 set to logic low 7
112 128 DUT Control Line 8 set to logic low 8
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Control Lines

The 15 pin female D-Sub connector on the rear panel provides 8 latched data lines that can
be used to control your device under test (DUT). The lines can be controlled with the
multiport external test set control, or Test Set /O commands. Refer to “External Test Set
Control Operation” on page 19 and “Setting the Control Lines with Address and Data
Values” on page 34. See Table 8 for DUT control line specification.

The output voltage of the lines can be from the internal adjustable voltage source (+2 to
+5 Vde), or an external dc power supply depending on how the connection to the control
line is configured. When using an external power supply a positive or negative voltage can
be used. Refer to Figure 27 and Table 9 on page 36 for control line pin location and
description. Refer to “Internal Voltage Supply Configuration” on page 37 and “External
Voltage Supply Configuration” on page 38 for configurations.

Table 8 DUT Control Specifications

Item Specifications
Connector Type D—Sub, 15—pin female
Max Output Line Current 100 mA (each line)
Control Line DC resistance <10 Q (each line)

Voltage Range:

Positive Input 0Oto+5V
Negative Input -5to0V
Internal Variable Voltage +2to+5V
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Figure 27 DUT Control Line Pin Assignment (rear panel view)

Table 9 DUT Control Line Interface Connector Pin Assignment
Pin Signal Name | Description
1 Line 1 Control Line Output of the latched voltage from pin 13 or pin 14.
2 Line 2 Control Line Output of the latched voltage from pin 13 or pin 14.
3 Line 3 Control Line Output of the latched voltage from pin 13 or pin 14.
4 Line 4 Control Line Output of the latched voltage from pin 13 or pin 14.
5 Line 5 Control Line Output of the latched voltage from pin 13 or pin 14.
6 Line 6 Control Line Output of the latched voltage from pin 13 or pin 14.
7 Line 7 Control Line Output of the latched voltage from pin 13 or pin 14.
8 Line 8 Control Line Output of the latched voltage from pin 13 or pin 14.
9,10& 11 Not used
12 +2Vto+5V Internal voltage output, adjusted with the trimmer on the rear panel.
13 Positive Input | Connection for internal (pin 12) or external positive voltage supply.
14 Negative Input | Connection for ground (pin 15) or external negative voltage supply.
15 Gnd ground terminal
36
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Internal Voltage Supply Configuration

Control Lines

The output voltage of pin 12 can be adjusted from +2 to +5 V. Perform the following

procedure to set the voltage:

1. Turn On the Test Set.

2. Measure the voltage between pin 12 and 15 using a multimeter.

3. Rotate the voltage adjustment trimmer on the rear panel until the multimeter indicates

the selected voltage.

Figure 28 illustrates an example of the connection between the DUT and the Test Set
using the internal dc power supply. Connect pin 12 to pin 13 and pin 14 to pin 15 to provide
the ground path. Connect the control lines to the external DUT.

CAUTION You may only connect pin 12-13, and pin 14-15, damage may result if any

other paths are short-circuited.

Figure 28 Internal DC Power Configuration (rear panel view)
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External Voltage Supply Configuration

Figure 29 illustrates an example of the connection with an external dc power supply.
Connect the positive and negative voltage supply from the external power supply to the
positive input (pin 13) and the negative input (pin 14). Connect the power supply dc

ground to pin 15.

Turning On the Test Set using an External Power Supply

1. Turn On the Test Set.

2. Connect the DUT.

3. Turn On the external power supply.

Turning Off the Test Set using an External Power Supply

1. Turn Off the Power Supply.
2. Turn Off the Test Set.
3. Disconnect the DUT.

Figure 29 Test Set to the DUT and External DC Power Supply
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Operational Check

This operational check is to confirm the Test Set and PNA-X operational performance. The
operation verification limits provided ensure that your U3045AMO08 and PNA-X are
operating properly. Refer to “Verifying Operational Check Failures” on page 45 to ensure
the RF interface cables are installed and working correctly before returning the Test Set
for repairs.

Verification Limits

Specifications for the Test Set are typical. System performance for the PNA-X and Test Set
are only characteristic and intended as non-warranted information. Only a functional
certificate is provided for the Test Set.

It is recommended that you return your instrument to Agilent Technologies for servicing or
repair if the Test Set and PNA-X performance exceed the operational verification limits.

A periodic calibration is not required. The Operators Check should be performed after
System Setup, or if performance is in question. An N-Port calibration should be performed
before making a measurement.

Table 10  N524/445A Operation Verification Limitsfor Reflection Tracking!

Frequency Port 1-12
10 MHz to 5 GHz -5dB
5 GHz to 15 GHz -7dB
15 GHz to 25 GHz -10 dB
25 GHz to 35 GHz -12dB
35 GHz to 50 GHz -15dB

1. Reflection Tracking takes into account Source Loss,
Receiver Loss, Margin, and PNA-X Mixer Cal.

NOTE If you suspect that your 12-Port configuration is not operating properly,
ensure that all front RF jumper interconnect cables are correctly attached.
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Equipment Required

The Agilent U3045AMOS8 requires that the user be familiar with the equipment listed.
Table 11 Equipment List

Description Qty
N4693A 2.4 mm ECal Module 10 MHz - 50 GHz (Option 00F or MOF) or 1
850578 Verification Kit.

N5244/45A Option 400 and 551 1
Set of interconnect cables (PNA-X and Test Set), see “RF Interface Cable 1
Connections” on page 15.

Operational Check Procedure

The sequence of this procedure is very important and must be followed or the performance
accuracy and results may vary from the reference plots provided. Ensure that the Test Set
is not connected to the PNA-X if you are performing a PNA-X Operator’s Check. The
PNA-X will indicate false failures if the Test Set is connected.

Preparing the N5244/45A

1. Connect the Test Set to the 4-Port PNA-X using the interconnect cables as shown in
Figure 10 on page 15 and Table 5 on page 15.

2. Turn On the Test Set.

3. On the PNA-X, select Response > Cal > Manage Cals > Cal Set. Delete or Rename any
Cal Sets titled “999.1” thru “999.12” (12-Port), although it is unlikely that you will find
Cal Sets with these names.

4. Verify that the PNA-X is in 12-Port. See the bottom of the measurement window.

a. Ifonly four S-Parameters are listed, select Utility > System > Configure > Multiport
Capability. Select Restart as multiport PNA with this testset and select U3045AMO08
(12-Port) from the drop-down menu > OK. Refer to Figure 13 on page 18.

Press Preset.
Verify that the [Start Frequency] is set to [10 MHZz].
Verify that the [Stop Frequency] is set to [50 GHZz], or [43.5 GHZz] for the N5244A.

Verify that the [Power] is to set to [-15 dBm]. If not, select [Power] > Power Level and
enter [-15 dBm].

9. Select Response > Avg > IF Bandwidth > 100 Hz > OK.
10.Select Stimulus > Sweep > Number of Points > 401.

11.Connect the ECal module to an available PNA-X USB port on the front or rear panel.
Refer to Figure 10 on page 15. This procedure assumes you are using a ECal. If you are
not, see “N5244/45A 1-Port Calibration and Verification Procedure” on page 41, step 2.

® =2 o

12.Allow the ECal module, Test Set and PNA-X to warm up for a minimum of 30 minutes.
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N5244/45A 1-Port Calibration and Verification Procedure

1. Connect the ECal or the mechanical cal kit to Port 1 or the port you are testing. Refer to
Torque to 8 in-1b. For further information refer to the Help menu, see Figure 30.

2. Perform a 1-Port Calibration on Port 1. On the PNA-X, select Response > Cal > Start
Cal > Calibration Wizard.

a. If using a mechanical cal kit, select SmartCal (Guided Calibration) > Next.

b. If using an ECal module, connect the ECal to a PNA-X USB port. Select Use
Electronic Calibration (ECal) > Next.

3. Continue following the Cal Wizard prompts. In the Select Calibration Ports and ECal
Module dialog box click Clear All, then select Port 1 > Next > Measure.

Figure 30 1-Port Calibration
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™ Show &dvanced Settings [Drientation & Thru Cal Section)

< Back I Mext » I Cancel I Help |

4. Continue to follow the prompts until the Calibration Completed dialog box appears.

5. At the Calibration Completed prompt, select Save As User Calset, type the name 999.1.
Overwrite the Calset if it already exists and Save.

NOTE If you do not have a key board, select Save As User Calset > Edit Name and
save as 999.x. X is the port number you are calibrating. Refer to Figure 31 on
page 41. Use the numeric keypad on the PNA-X front panel to enter “999.1.”

Figure 31 Calibration Complete

Calibration completed in Channel 1 x

This calibration will be saved in the Channel 1 Cal Register when you exit the wizard.

Press Finish to exit, or

Press "Save As ser Calset "
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<Back IWI Cancel | Help | Selact calset From list or bype new name below:
[
Edit Name ‘
save | cancel | heb |
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6. Repeat step 1 thru step 5 for Ports 2 thru 12. When finished, there should be 12 Cal
Sets saved with the titles “999.1” thru “999.12” (12-Port).

If you are using an ECal module you can verify the individual port calibration by
selecting Response > Cal > More > ECal > ECal Confidence Check. Click Change
Measurement and select the test port S-Parameter > Apply > OK, and click

Read Module Data. For further information refer to the Help menu.

Figure 32 ECal Confidence Check
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7. Select Trace/Chan > Trace > Delete Trace. There should be no traces on the PNA-X
screen.

8. To launch the Cal Set Viewer toolbar. Select Response > Cal > Manage Cals >
Cal Set Viewer.

Figure 33 Calibration, Cal Set Viewer
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9. From the Cal Sets drop-down menu, select 999.1 and select Enable. Select the
Reflection Tracking(x,x), where x,x is the port being tested, term in the center
drop-down menu and ensure that the Enable and Error Terms check boxes are selected.

10.Compare the Reflection Tracking (1,1) trace to the appropriate limits in Table 10 on
page 39. You may also create a table on the PNA-X and enter the limit line stimulus and
response values. Select Marker/Analysis > Analysis > Limit Test > Limit Test ON and
Limit Line ON > Global pass/fail display ON, then click Show Table. The trace should
be above the limit. PASS will be displayed on the screen if the limit lines are used.

11.Repeat step 9 and step 10 for Cal Sets “999.1” thru “999.12” (12-Port).
Figure 34 PNA-X Setting the Test Limits
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Figure 35 Reflection Tracking Trace with Limit Line Table
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Figure 36 Standard Reflection Tracking Trace (Port 1-4) with PNA-X
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Figure 37 Standard Reflection Tracking Trace (Port 5-12) with PNA-X

File Trace/Chan Response Marker/Analysis Stimulus Utility Help
Cal Sets Display: @ EmorTerms  ( Standards )
939 5 [ReflectionTracking(s 51 JE2 CalSet Viewer

8 ReflectionT(5,5) LagM 10.00dB/ 0.00dB

50.00

40.00

30.00

20.00

10.00

0.00

-10.00

-20.00

-30.00

-40.00
Favorites

Honn 1T 22 33 4[4 5[5 &6 77 88 o[ 1000 1111 1212
Hold  CH 20ReflectionT(5,5) No Cor LCL

44 User’s and Service Guide U3045-90001



U3045AMO08 Operational Check

Verifying Operational Check Failures

If your test results fail the Operational Check limits, verify following:

1. Insure that the Test Set is turned on and connected properly to the PNA-X.

2. Check all appropriate PNA-X and Test Set connectors for damage, cleanliness, and
proper torque.

3. Repeat the relevant 1-Port calibrations using another ECal or mechanical standard.

4. Verify that the PNA-X is operating properly and meeting its published specifications. If
the PNA-X is connected to the Test Set it will fail the Operational Check. Refer to
“Network Analyzer Requirements” on page 3.

Interconnect Cable Verification

1. Connect the Test Set to the PNA-X and select Multiport mode.
2. Verify the Source Interconnect RF cables (Source Out and CPLR THRU).

a.

b.

C.

Remove the Receiver and CPLR ARM interconnect cables and install the standard
PNA-X jumpers.

Connect two RF cables on the PNA-X, Port-1 to Port-2 and Port-3 to Port-4.

Set the PNA-X to measure Trace S12, S21, S34 and S43, and verify that there are no
power holes. If S12, or S34 has a power hole check the Port-2, or Port-4 Source
interconnect cables and Test Set connectors for damage. If S21, or S43 has a power
hole check the Port-1, or Port-3 Source interconnect cables and Test Set connectors
for damage.

3. Verify the Receiver Interconnect RF cables (Receiver A IN or B IN and CPLR ARM).

a.

b.

Re-install the Receiver and CPLR ARM interconnect cables.

Remove the Source Out and CPLR THRU interconnect cables and install the
standard PNA-X jumpers.

Set the PNA-X to measure Trace S12, S21, S34 and S43. Verify that there are no
power holes. If S12 or S34 has a power hole check Port-1, or Port-3 Receiver
Interconnect cables and Test Set connectors for damage. If S21, or S43 has a power
hole check Port-2, or Port-4 Receiver Interconnect cables and Test Set connectors for
damage.

4. If the problem still exists, connect the standard jumpers to the PNA-X (Source and
Receiver) and verify the Source Out to CPLR THRU and A/B IN to CPLR ARM switch
paths.

a.
b.

C.

Connect two RF cable, one to Port-1 and one to Port-2.
Set the PNA-X to measure trace S12 (all standard jumpers connected).

Connect the Port-1 cable to Source Out and Port-2 cable to CPLR THRU connectors
on the Test Set. If a power hole still exists refer to “Contacting Agilent” on page 71.

. Connect Port-1 to Receiver A IN or B IN and Port-2 to CPLR ARM connectors on the

Test Set. If a power hole still exists refer to “Contacting Agilent” on page 71.
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Service Information

This section provides information to troubleshoot and repair the U3045AMOS test set.
Refer to “Agilent Support, Services, and Assistance” on page 71 for information on
returning your test set to Agilent Technologies.

WARNING No operator serviceable parts inside. Refer servicing to qualified
personnel. To prevent electrical shock do not remove covers.

WARNING These servicing instructions are for use by qualified personnel only.
To avoid electrical shock, do not perform any servicing unless you
are qualified to do so.

Replaceable Parts

The following replaceable parts are available from Agilent Technologies “Find-A-Part”
system on the web at www.parts.agilent.com.

Table 12 Available Replacement Parts (SPO)

Description Agilent Part

Number
Switch, Multiport (50 GHz terminated) N1811-60023
Fuse (5 A 250 V non-time delay Socket 2110-0709

Fuse (8 A 250 V non-time delay 0.0146 Ohm 2110-0342

PWR Supply (AC/DC SWG 650W 9- Output | 0950-4729

Couplers 5087-7724
PNA-X Locking Feet 5023-0132
Test set I/O Cable 8120-6818
Fan (rear panel) 87050-60027
DUT Control Board E5091-66503
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The following replaceable parts may be ordered by sending an e-mail request to
ctd-soco_support@agilent.com. Be sure to include test set model, options and serial
number. Some parts may have long lead times.

Table 13  Replaceable Parts (M08)

Description Agilent
Part Number

RF Cable, Semi-rigid U3047-20016
RF Cable, Semi-rigid U3047-20017
SW Interface Board, programmed U3025-60062
U3045AMO08 User’s and Service Guide U3045-90001
Dress Nut (couplers) N5230-20081
PNA-X Test Set Rear Lock Feet (right) N5242-20138
PNA-X Test Set Rear Lock Feet (left) N5242-20139
Front Panel LED Board (programmed) N5261-60005
Test Set Control Board (programmed) N5261-60006
Screw-Pan Head Machine with thread patch, | 0515-2317
Torx-T15 M3.5 with 0.6 thread, 12 mm-LG

User’s and Service Guide (Option M08) U3045-90001
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System Block Diagram

Figure 38 U3045AMO08 RF Block Diagram
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U3045AMO08

Figure 39 Electrical Block Diagram
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Theory of Operation

The following is a description of the operation of the Test Set. Reference the Test Set block
diagrams shown in Figure 26 on page 33. This section assumes the user has a general
understanding of couplers, switches, and network analyzers.

The Test Set adds eight test ports to a 4-Port N5244/45A PNA-X Network Analyzer. The
internal RF switches direct the source output and receiver input to the selected port
coupler.

The switches and couplers are arranged in four groups to control the source and receiver
paths of the PNA port to the couplers in the column under the PNA port.

RF Coupler

The Test Set uses eight couplers (5087-7724) on the front panel for RF Test Ports
5 - 12. The couplers provide the signal separation of the source and receiver paths. The
Test Set ports can receive from or stimulate a signal to the DUT.

The RF Test Port connectors are male 2.4 mm. The coupling factor is approximately —18 dB
for the Coupled Arm for frequencies > 1 GHz to 50 GHz (approximately —-53 dB < 1 GHz).
The insertion loss through the CPLR THRU path is typically < 4 dB at 50 GHz.

RF Switch Components

The Test Set uses sixteen mechanical switches that have internal 50 Q termination and a
external 50 Q termination (00901-60003). The switches select the RF paths from the
PNA-X source and receiver through interconnect cables to the Test Set.

Source and Receiver Switch Paths

SW1 and SW2 - Source to Ports (1, 5 and 9) Switch 1 and 2 provide control of the
Source Output path to PNA-X Port 1 and Test Set Ports 5 and 9. In the state shown in the
block diagram, switch 1 routes the RF Source back to the PNA-X Port 1, and the Test Set
Source path to Port 5 and 9 are terminated.

SW5 and SW6 - Source to Ports (3, 6 and 10) Switch 5 and 6 provide control of the
Source Output path to PNA-X Port 3 and Test Set Port 6 and 10. In the state shown in the
block diagram, switch 5 routes the RF Source back to the PNA-X Port 3, and the Test Set
Source path to Ports 6 and 10 are terminated.

SW9 and SW10 - Source to Ports (4, 7 and 11) Switch 9 and 10 provide control of the
Source Output path to PNA-X Port 4 and Test Set Port 7 and 11. In the state shown in the
block diagram, switch 9 routes the RF Source back to the PNA-X Port 4, and the Test Set
Source path to Ports 7 and 11 are terminated.
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SW13 and SW14 - Source to Ports (2, 8 and 12) Switch 13 and 14 provide control of
the Source Output path to PNA-X Port 2 and Test Set Port 8 and 12. In the state shown in
the block diagram, switch 13 routes the RF Source back to the PNA-X Port 2, and the Test
Set Source path to Ports 8 and 12 are terminated.

SW3 and SW4 - Receiver to Ports (1, 5 and 9) Switch 3 and 4 provide control of the
Receiver Input path to PNA-X Port 1 and Test Set Port 5 and 9. In the state shown in the
block diagram, switch 3 routes the Port 1 Coupler Arm to the Receiver, and Test Set Ports
5 and 9 Coupler Arm path is terminated.

SW7 and SWS8 - Receiver to Ports (3, 6 and 10) Switch 7 and 8 provide control of the
Receiver Input path to PNA-X Port 3 and Test Set Ports 6 and 10. In the state shown in the
block diagram, switch 7 routes the Port 3 Coupler Arm to the Receiver, and Test Set Ports
6 and 10 Coupler Arm path is terminated.

SW11 and SW12- Receiver to Ports (4, 7 and 11) Switch 11 and12 provide control of
the Receiver Input path to PNA-X Port 4 and Test Set Ports 7 and 11. In the state shown in
the block diagram, switch 11 routes the Port 4 Coupler Arm to the Receiver, and Test Set
Ports 7 and 11 Coupler Arm path is terminated.

SW15 and SW16 - Receiver to Ports (2, 8 and 12) Switch 15 and 16 provide control of
the Receiver Input path to PNA-X Port 2 and Test Set Port 8 and 12. In the state shown in
the block diagram, switch 15 routes the Port 2 Coupler Arm to the Receiver, and Test Set
Ports 8 and 12 Coupler Arm path is terminated.
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Troubleshooting the Test Set

If the U3045AMO8 is not operating properly, use the following procedures to isolate and
repair the type of failure encountered. It is recommended that a qualified service
technician perform the following procedures.

Refer to the Agilent PNA Series: Service & Support Home Page at:
http:/ I na.tm.agilent.com /pna for further information.

To request service, please contact your local service center. In the US, call 800-829-4444.
For a listing of service centers worldwide, please visit us at www.agilent.com/find/service.

When sending the Test Set in for repair, please also send your PNA and cables. This will
allow us to verify proper operation of the complete system, and speed your repair
turn-around time. Refer to “Agilent Support, Services, and Assistance” on page 71.

Refer to the following procedures for troubling shooting. It is recommended that a qualified
service technician perform the following procedures.

WARNING No operator serviceable parts inside. Refer servicing to qualified
personnel. To prevent electrical shock do not remove covers.

Fan is not Operating

Suspect a power supply problem or failed fan, and perform the following troubleshooting.

WARNING The opening of covers or removal of parts is likely to expose the user
to dangerous voltages. Disconnect the instrument from all voltage
sources before being opened.

1. Verify the front panel power switch (3101-4058) is operational.

2. Verify that the AC line voltage is correct (100 to 240 V @ 50/60 Hz) and that the power
cord is not damaged.

a. If the power cord is damaged, replace it.
b. If the AC line voltage is incorrect, use another receptacle.

3. Verify that the fuse (2110-0709) in line module is not blown. There is a spare fuse in the
line module. Refer to Figure 4 on page 11. If the fuse is working, continue to step 4.

4. Remove the top cover. Verify that the supply LED indicators, on the test set control
board (N5261-60006) are illuminated. The +9 and +10 V supplies will not be on. If the
LED’s are illuminated, replace the fan (87050-60027). Refer to Figure 45 on page 63.

5. If the LED’s are off, verify the voltages (+24, +5, +3, -15, -12, +15, +12, +9 and -10
Volts) on the Test Set Controller board. If the voltages are not correct, verify that
J10 - J14 cables are connected correctly on both the power supply and controller board.
Refer to Figure 45 on page 63.

6. Ifthe J10 - J14 cables are connected properly, measure the voltages on the power supply
screw terminals. See the power supply voltages in Figure 40 on page 53.
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Figure 40 Test Set Power Supply

7.

If power supply voltages are not present, verify and/or replace the two 8 amp fuses
(2110-0342) in the line fuse assembly. Refer to Figure 45 on page 63.

a. If the fuses are correct, replace the power supply (0950-4729).

Front Panel LEDs (R, S or Active) are not Illuminated

If the U3045AMO8 fan and power supplies are operating the following procedures can be
used to verify the failure. Suspect the Test Set Controller Board (N5261-60006) or Front
Panel LED Assembly (N5261-60005).

1.
2.

Verify the Test Set I/0 cable (8120-6818) is installed correctly. See Figure 11 on page 16.

Using multiport mode (Option 551), verify the PNA firmware is correct, and the test set
file is loaded into the PNA, refer to “Network Analyzer Requirements” on page 3.

. Using the I/O command values, confirm the correct address and data values are used.

Refer to “Address and Data Values” on page 32.

. Remove the top cover. Verify that the supply LED indicators, on the test set control

board (N5261-60006), are illuminated.

. If the LED’s are off, verify the voltages(+24, +5, +3, -15, =12, +15, +12, +9 and -10

Volts) on the Test Set Controller board. If the voltages are not correct, verify that
J10 - J14 cables are connected correctly on both the power supply and controller board.
Refer to “Fan is not Operating” on page 52.

. Verify at least one of the status LEDs is on. If not, replace the controller board

(N5261-60006).

. If the controller board status LEDs are on, and the Active LED is on, suspect the front

panel LED boards (N5261-60005) or the ribbon cables (N5261-60001). If only one set of
front panel LEDs are not working, connect the ribbon cable from one of the working
front panel LED boards to the front panel LED board assembly that is not working.
Replace if necessary.
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Test Ports are not Switching

If the test ports are not switching, the following procedures can be used to verify the
failure. The procedures assume power supplies, controller board and front panel LEDs are
working. Suspect the switch interface board (U3025-60062), ribbon cable connection or
coax switch (N1811-60023).

1. Inspect the ribbon cable connections from the test port switches to the Switch Interface
board (U3025-60062). Refer to Table 15 on page 62.

2. Send a test set I/O command and verify that the mechanical switches are make a
clicking sound. If there is no sound, replace the Switch Interface board (U3025-60062)
or the suspected switch (N1811-60023).

3. If the switches are operating, send a test set /O command to verify the path for each
port. See “Source and Receiver Path Test” on page 54.

4. Substitute a known good switch, or connect a known good ribbon cable to a suspect
switch and retest. Replace if necessary.
Source and Receiver Path Test

This section provides information for testing the RF paths.

Equipment Required

e Nb5244/45A PNA-X

¢ Two Flex Cable with SMA connectors (5062-6696 or equivalent)
e Three SMA Adapters (female to female)

e Test Set I/O Cable (8120-6818)

Equipment Setup

1. Connect the Test Set I/O cable (8120-6818) from the PNA to Test Set. Refer to Figure 11
on page 16. Set PNA to “Standalone mode” (Test can not be performed in Multiport
mode).

2. Connect the flexible cables (5062-6696 or equivalent) with the SMA adapters to PNA
Ports 1 and 2. Connect the cables together using a SMA adapter.

3. Set the frequency range to 10 MHz to 50 GHz, or the frequency range of the PNA you
are using.

4. Select measure S21 trace, and perform a Response Cal.
5. Select Ref Level 0 dB > Scale 2 dB (or Autoscale).
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Source Path Trace

The S21 trace should be approximately —0 to —3.5 dB (+/-1 dB) for all CPLR THRU (SMA)
to SOURCE IN paths. Refer to the individual port path to be tested. Refer to Figure 2 on
page 9 for the connector locations, and Figure 42 on page 59 for example path response.

The S21 trace should be approximately —0 to —7 dB (+/-1 dB) for test Ports 5 thru 12 to
SOURCE IN (SMA) paths. Refer to Figure 43 on page 60 for example path response.

Port 1 Source

e Set Test I/O addr.data 0.0

¢ Connect PNA Port 1 flex cable to Test Set Port 5 CPLR THRU.
¢ Connect PNA Port 2 flex cable to Test Set Port 5 SOURCE IN.
Port 3 Source

e Set Test I/O addr.data 16.0

¢ Connect PNA Port 1 flex cable to Test Set Port 6 CPLR THRU.
e (Connect PNA Port 2 flex cable to Test Set Port 6 SOURCE IN.
Port 4 Source

e Set Test I/O addr.data 32.0

¢ Connect PNA Port 1 flex cable to Test Set Port 7 CPLR THRU.
¢ Connect PNA Port 2 flex cable to Test Set Port 7 SOURCE IN.
Port 2 Source

e Set Test I/O addr.data 64.0

¢ Connect PNA Port 1 flex cable to Test Set Port 8 CPLR THRU.
e Connect PNA Port 2 flex cable to Test Set Port 8 SOURCE IN.
Port 5 Source

e Set Test I/O addr.data 0.1

¢ Connect PNA Port 1 flex cable to Test Set Port 5.

¢ Connect PNA Port 2 flex cable to Test Set SOURCE IN.
Port 6 Source

¢ Set Test I/O addr.data 16.1

e Connect PNA Port 1 flex cable to Test Set Port 6.

e (Connect PNA Port 2 flex cable to Test Set SOURCE IN.
Port 7 Source

e Set Test I/0 addr.data 32.1
e Connect PNA Port 1 flex cable to Test Set Port 7.
e Connect PNA Port 2 flex cable to Test Set SOURCE IN.
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Port 8 Source

e Set Test I/O addr.data 64.1
e Connect PNA Port 1 flex cable to Test Set Port 8

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 9 Source

e Set Test I/0 addr.data 0.2
e Connect PNA Port 1 flex cable to Test Set Port 9.

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 10 Source

e Set Test I/O addr.data 16.2
e Connect PNA Port 1 flex cable to Test Set Port 10.

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 11 Source

e Set Test I/O addr.data 32.2
e Connect PNA Port 1 flex cable to Test Set Port 11

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Port 12 Source

e Set Test I/0 addr.data 64.2
e Connect PNA Port 1 flex cable to Test Set Port 12

e Connect PNA Port 2 flex cable to Test Set SOURCE IN.

Service Information
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Receiver Path Trace

The S21 trace should be approximately —0 to —3.5 dB (+/-1 dB) for all RCVR OUT (SMA) to
CPLR ARM paths. Refer to the individual port path to be tested. Refer to Figure 2 on
page 9 for the connector locations, and Figure 41 on page 59 for example path response.

The S21 trace should be approximately —18 dB (+/-1 dB) for frequencies > 1 GHz, and
—50 dB for frequencies < 1 GHz. This is to due to the couplers low frequency response for
test Ports 5 thru 12 to RCVR OUT paths. Refer to Figure 44 on page 60 for example path
response.

Port 1 RCVR

e Set Test I/O addr.data 0.0

¢ Connect PNA Port 1 flex cable to Test Set Port 5 CPLR ARM.
e Connect PNA Port 2 flex cable to Test Set Port 5 RCVR OUT.
Port 3 RCVR

e Set Test I/O addr.data 16.0

e Connect PNA Port 1 flex cable to Test Set Port 6 CPLR ARM.
¢ Connect PNA Port 2 flex cable to Test Set Port 6 RCVR OUT.
Port 4 RCVR

e Set Test I/O addr.data 32.0

¢ Connect PNA Port 1 flex cable to Test Set Port 7 CPLR ARM.
e Connect PNA Port 2 flex cable to Test Set Port 7 RCVR OUT.
Port 2 RCVR

e Set Test I/O addr.data 64.0

e Connect PNA Port 1 flex cable to Test Set Port 8 CPLR ARM.
¢ Connect PNA Port 2 flex cable to Test Set Port 8 RCVR OUT.
Port 5 RCVR

e Set Test I/O addr.data 0.16

¢ Connect PNA Port 1 flex cable to Test Set Port 5.

e Connect PNA Port 2 flex cable to Test Set Port 5 RCVR OUT.
Port 6 RCVR

¢ Set Test I/O addr.data 16.16

e Connect PNA Port 1 flex cable to Test Set Port 6.

¢ Connect PNA Port 2 flex cable to Test Set Port 6 RCVR OUT.
Port 7 RCVR

e Set Test I/0 addr.data 32.16
e Connect PNA Portl flex cable to Test Set Port 7.
e Connect PNA Port 2 flex cable to Test Set Port 7 RCVR OUT.
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Port 8 RCVR

¢ Set Test I/O addr.data 64.16

e Connect PNA Port 1 flex cable to Test Set Port 8.

¢ Connect PNA Port 2 flex cable to Test Set Port 8 RCVR OUT.
Port 9 RCVR

e Set Test I/0 addr.data 0.32

¢ Connect PNA Port 1 flex cable to Test Set Port 9.

¢ Connect PNA Port 2 flex cable to Test Set Port 9 RCVR OUT.
Port 10 RCVR

e Set Test I/O addr.data 16.32

e Connect PNA Port 1 flex cable to Test Set Port 10.

¢ Connect PNA Port 2 flex cable to Test Set Port 10 RCVR OUT.
Port 11 RCVR

e Set Test I/O addr.data 32.32

¢ Connect PNA Port1 flex cable to Test Set Port 11.

¢ Connect PNA Port 2 flex cable to Test Set Port 11 RCVR OUT.
Port 12 RCVR

e Set Test I/O addr.data 64.32
e Connect PNA Port 1 flex cable to Test Set Port 12.
e Connect PNA Port 2 flex cable to Test Set Port 12 RCVR OUT.

Service Information
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Figure 41 CPLR ARM to RCVR OUT
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Figure 42 CPLR THRU to SOURCE IN
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Figure 43 Test Port CPLR THRU to SOURCE IN
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Figure 44 Test Port CPLR ARM to RCVR OUT
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RF Performance Fails

If the U3045AMOS8 operates correctly, but RF performance fails the operational test. The
following procedures can be used to isolate the failed component. Suspect the coax switches
(N1811-60023), RF cables, or coupler (5087-7724).

NOTE The RF performance of the U3045AMO08 depends on the performance of the
PNA. Ensure the PNA is meeting specification before continuing.

1. Verify that the test set and PNA SOURCE, RCVR, CPLR THRU, and CPLR ARM
connectors are clean and that the center pins are not damaged.

2. Verify the interface and internal RF cables are cleaned and not damaged. “Verifying
Operational Check Failures” on page 45.

3. Review the “Operational Check” on page 39 and verify the results for the port that is
failing.

4. Reflection tracking trace shows a power hole, or is below the test limit line, perform the
switch path test for the port that is failing. Refer to “Source and Receiver Path Test” on
page 54.

5. Directivity trace fails (above —10dB), replace the couplers (5087-7724).
6. Source or load match fails (above —10 dB), replace the coax switch (N1811-60023).

7. Isolation is poor between ports, inspect the RF connections. If it continues to fail replace
the coax switch (N1811-60023). The RF cables require proper torque (10 in-lb) and can
be damaged by over tightening.

Control Lines are not Working

If the U3045AMO8 operates correctly but the control lines are not functioning, the
following procedures can be used to verify the component failure. Suspect the DUT
CONTROL BD (E5091-66503).

1. Verify that the control voltage pins on the DUT control are connected correctly. Refer to
“Control Lines” on page 35.

Verify that the control pot is centered (5V). Refer to Figure 3 on page 10.
Verify the ribbon cable connection.

Replace the DUT control board (E5091-66503).

Replace the test set control board (N5261-60006).

AR
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Troubleshooting Diagrams and Tables

Table 14

Controller Board Connections

Controller Bd Connection

Connection

LED Ribbon Cables From the LED Board

J5 Ports 5, 6, 7 and 8

J6 Ports 9, 10, 11 and 12
Wire harness Active LED

J16 Active LED
DUT Control Ribbon Cable

J9 DUT Controller Board

Power Supply Wire Harness

J10- 14 Power Supply
J18 Fan
Table 15 Switch Interface Board
SW # Interface Bd Ports Path
Connection

1 J10 1,5and 9 Source

2 J11 1,5and 9 Source

3 J13 1,5and 9 Receiver
4 J14 1,5and 9 Receiver
5 J20 2,6 and 10 Source

6 J21 2,6 and 10 Source

7 J22 2,6 and 10 Receiver
8 J24 2,6 and 10 Receiver
9 J30 3,7 and 11 Source
10 J31 3,7and 11 Receiver
11 J32 3,7and 11 Receiver
12 J34 3,7and 11 Source
13 J40 4,8 and 12 Source
14 J41 4,8 and 12 Receiver
15 J42 4,8 and 12 Receiver
16 J44 4,8 and 12 Receiver

Service Information

62

User’s and Service Guide U3045-90001



U3045AMO08 Service Information

Figure 45 Test Set Top View
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Figure 46 Test Set Bottom View
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Safety and Regulatory Information

Introduction

Review this product and related documentation to familiarize yourself with safety
markings and instructions before you operate the instrument. The documentation contains
information and warnings that must be followed by the user to ensure safe operation and
to maintain the product in a safe condition.

Safety Earth Ground

WARNING This is a Safety Class I Product (provided with a protective earthing
ground incorporated in the power cord). The mains plug shall be
only be inserted in a socket outlet provided with a protective earth
contact. Any interruption of the protective conductor inside or
outside of the product is likely to make the product dangerous.
Intentional interruption is prohibited.

CAUTION Always use the three prong AC power cord supplied with this product. Failure
to ensure adequate earth grounding by not using this cord may cause product
damage and the risk of electrical shock.

Declaration of Conformity

A copy of the Declaration of Conformity is available upon request, or a copy is available on
the Agilent Technologies web site at
http:/ I regulations.corporate.agilent.com / DoC/ search.htm

Statement of Compliance

This instrument has been designed and tested in accordance with CAN/CSA 22.2
No. 61010-1-04, UL Std. 61010-1 (2nd Edition), and IEC 61010-1 (Second Edition).
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Safety and Regulatory Information

Before Applying Power

Verify that the premises electrical supply is within the range of the instrument. The
instrument has an autoranging power supply.

WARNING

If this product is not used as specified, the protection provided by the
equipment could be impaired. This product must be used in a normal
condition (in which all means for protection are intact) only.

CAUTION

The Mains wiring and connectors shall be compatible with the connector used
in the premise electrical system. Failure, to ensure adequate earth grounding
by not using the correct components may cause product damage, and serious
injury.

CAUTION

This product is designed for use in Installation Category II and Pollution
Degree 2.

CAUTION

Verify that the premise electrical voltage supply is within the range specified
on the instrument.

CAUTION

When installing the product in a cabinet, the convection into and out of the
product must not be restricted. The ambient temperature (outside the
cabinet) must be less than the maximum operating temperature of the
product by 4 °C for every 100 watts dissipated in the cabinet. If the total
power dissipated in the cabinet is greater than 800 watts, then forced
convection must be used.

CAUTION

This instrument has auto-ranging line voltage input, be sure the supply
voltage is within the specified range and voltage fluctuations do not to exceed
10 percent of the nominal supply voltage.

66
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Servicing
WARNING Danger of explosion if battery is incorrectly replaced. Replace only with the

same or equivalent type recommended. Discard used batteries according to
manufacturer’s instructions.

WARNING

These servicing instructions are for use by qualified personnel only. To
avoid electrical shock, do not perform any servicing unless you are
qualified to do so.

WARNING

The opening of covers or removal of parts is likely to expose the user to
dangerous voltages. Disconnect the instrument from all voltage sources
before opening.

WARNING

No operator serviceable parts inside. Refer servicing to qualified personnel.
To prevent electrical shock, do not remove covers.

WARNING

The detachable power cord is the instrument disconnecting device. It
disconnects the mains circuits from the mains supply before other parts of
the instrument. The front panel switch is only a standby switch and is not a
LINE switch (disconnecting device).

WARNING

The power cord is connected to internal capacitors that may remain
live for 5 seconds after disconnecting the plug from its power supply.

Connector Care and Cleaning Precautions

Remove the power cord to the instrument. To clean the connectors use alcohol in a well
ventilated area. Allow all residual alcohol moisture to evaporate, and fumes to dissipate
prior to energizing the instrument.

WARNING To prevent electrical shock, disconnect the Agilent Technologies U3045A
Option M08 from mains electrical supply before cleaning. Use a dry cloth or
one slightly dampened with water to clean the external case parts. Do not
attempt to clean internally.

WARNING If flammable cleaning materials are used, the material shall not be stored,

or left open in the area of the equipment. Adequate ventilation shall be
assured to prevent the combustion of fumes, or vapors.
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Electrostatic Discharge Protection

Protection against electrostatic discharge (ESD) is essential while removing assemblies
from or connecting cables to the instrument. Static electricity can build up on your body
and can easily damage sensitive internal circuit elements when discharged. Static
discharges too small to be felt can cause permanent damage. To prevent damage to the
instrument:

always have a grounded, conductive table mat in front of your test equipment.

always wear a grounded wrist strap with grounding cord, connected to a grounded
conductive table mat, having a 1 MQ resistor in series with it, when handling
components and assemblies or when making connections.

always wear a heel strap (9300-1126) when working in an area with a conductive floor.
If you are uncertain about the conductivity of your floor, wear a heel strap.

always ground yourself before you clean, inspect, or make a connection to a
static-sensitive device or test port. You can, for example, grasp the grounded outer shell
of the test port or cable connector briefly.

always ground the center conductor of a test cable before making a connection to the
analyzer test port or other static-sensitive device. This can be done as follows:

1. Connect a short to one end of the cable to short the center conductor to the outer
conductor.

2. While wearing a grounded wrist strap, grasp the outer shell of the cable connector.

3. Connect the other end of the cable to the test port and remove the short from the
cable.

Figure 16 ESD Protection Setup

NOTE:

A 3-Wire line

power cord with proper
connection to ground
must be used for

ESD protection

Anti-Static Mat

ku310b
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Regulatory Information

Instrument Markings

This section contains information that is required by various government regulatory

agencies.

ICES/NMB-001

U

20

O nioiae

The instruction documentation symbol. The product is marked with this symbol
when it is necessary for the user to refer to the instructions in the documentation.

This symbol indicates separate collection for electrical and electronic equipment,
mandated under EU law as of August 13, 2005. All electric and electronic equipment
are required to be separated from normal waste for disposal (Reference WEEE
Directive, 2002/96/EC).

This symbol indicates that the power line switch is ON.

This symbol indicates that the power line switch is in the STANDBY position.

This symbol indicates that the power line switch is in the OFF position.

This symbol is used to identify a terminal which is internally connected to the
product frame or chassis.

The CE mark is a registered trademark of the European Community. (If accompanied
by a year, it is when the design was proven.)

The CSA mark is a registered trademark of the CSA International. This instrument
complies with Canada: CSA 22.2 No. 61010-1-04.

This is a symbol of an Industrial Scientific and Medical Group 1 Class A product.

This is a marking to indicate product compliance with the Canadian
Interference-Causing Equipment Standard (ICES-001).

Direct Current.

The instrument has been designed to meet the requirements of IP 2 0 for egress and
operational environment.

This is a required mark signifying compliance with an EMC requirement. The C-Tick
mark is a registered trademark of the Australian Spectrum Management Agency.

China RoHS regulations include requirements related to packaging, and require
compliance to China standard GB18455-2001.

This symbol indicates compliance with the China RoHS regulations for
paper/fiberboard packaging.
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Battery Collection

Do not throw batteries away but collect as small chemical waste, or in accordance with
your country’s requirements. You may return the battery to Agilent Technologies for
disposal. Refer to “Contacting Agilent” on page 71 for assistance.

Compliance with German Noise Requirements

This is to declare that this instrument is in conformance with the German Regulation on

Noise Declaration for Machines (Laermangabe nach der Maschinenlaermrerordnung-3.
GSGV Deutschland).

Acoustic Noise Emission/Geraeuschemission
LpA<70 dB Lpa<70 dB
Operator Position am Arbeitsplatz
Normal Operation normaler Betrieb
per ISO 7779 nach DIN 45635 t. 19
EMC Information

Complies with European EMC Directive 2004/108/EC
e TEC/EN 61326-1

¢ CISPR Pub 11 Group 1, class A

e AS/NZS CISPR 11

e This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme a la norme NMB du Canada.

70 User’s and Service Guide U3045-90001



U3045AMO08 Agilent Support, Services, and Assistance

Agilent Support, Services, and Assistance

Service and Support Options

The standard product warranty is a one-year return to Agilent Technologies service
warranty.

NOTE There are many other repair and calibration options available from the
Agilent Technologies support organization. These options cover a range of
service agreements with varying response times. Contact Agilent for
additional information on available service agreements for this product.

Contacting Agilent

Assistance with test and measurements needs and information or finding a local Agilent
office are available on the Web at:
http:/ lwww.agilent.com/find / assist

If you do not have access to the Internet, contact your field engineer.

NOTE In any correspondence or telephone conversation, refer to the Agilent product
by its model number and full serial number. With this information, the
Agilent representative can determine the warranty status of your unit.

Shipping Your Product to Agilent for Service or Repair

IMPORTANT Agilent Technologies reserves the right to reformat or replace the internal
hard disk drive in your analyzer as part of its repair. This will erase all user
information stored on the hard disk. It is imperative, therefore, that you
make a backup copy of your critical test data located on the analyzer’s hard
disk before shipping it to Agilent for repair.

If you wish to send your instrument to Agilent Technologies for service or repair:

¢ Toimprove turn-around time, return your Test Set along with your PNA-X and cables to
Agilent so that we may verify the operation of the complete system.

¢ Include a complete description of the service requested or of the failure and a
description of any failed test and any error message.

¢ Remove and retain the front handles and all rack mount hardware. The analyzer should
be sent to Agilent in the same configuration as it was originally shipped.

¢ Ship the analyzer using the original or comparable antistatic packaging materials.

¢ Contact Agilent for instructions on where to ship your analyzer.
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